
Viewing a Solution 

Introduction 
This chapter discusses the various ways in which you can view a 
completed manifest.  You will learn ways to progressively load or unload 
the vehicle to see how the load is constructed.  This chapter will also 
discuss in detail the various text reports that are available after calculating 
a solution.   

Though the process of building the various types of manifests is 
dramatically different, the options provided when viewing a solution are 
generally quite similar.  The majority of what we discuss in this chapter 
applies to the solutions calculated when building all four manifest types 
(truck, pallet, tote, single SKU).  Any differences will be highlighted. 

The various topics outlined in this chapter are as follows: 

 Manifest View Screen 
 

 Toolbar 
 View Buttons 
 Other View Options 
 Additional Viewing Options 
 Load Statistics 
 Tabs 
o Sol List 
o Placement List 
o Load List 
o Cut List 
 

 Viewing Items on the Cut List 

 SKU Information 
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Manifest View Screen 
To view a load, follow these instructions: 

1. Key in all of the necessary parameters in the Manifest Pick List screen 
and  click on the Calculate button. 

If the load has been previously calculated, open the manifest from the 
File menu and click on the View button.  The software will redraw 
what has already been calculated, and saved rather than recalculating 
the solution. 

System Response:  The View screen appears.  The MaxLoad Pro 
Manifest View screen, as pictured below, contains the primary results 
of your loaded manifest.  This screen includes both the loading 
diagram and all information associated with the manifest. 

 
Figure 8.1 Manifest View Screen 

The Menu Bar is essentially the same in this screen as it was in the 
Manifest Pick List screen, but notice the following differences: 

 Toolbar:  Icons, lists, and buttons below the Menu bar.   
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 View Buttons: Buttons, located in the upper, left-hand section of the 
screen providing quick and easy ways to view the solution from 
different angles. 

 Load Statistics:  Brief load statistics displayed under the view Buttons  

 Tabs:  A series of tabs/buttons, located at the bottom of the screen, 
displaying a number of lists with information about the load. 

 g.o.d. Window:  Displays a 3-dimensional graphic image of the 
container or pallet 

Toolbar (View Screen) 

The Toolbar on the View Screen is significantly different from the 
Toolbar on the Manifest Pick List screen.  It consists of various icons, 
lists, and buttons that are designed to make it easier to perform certain 
functions.   Items in the Toolbar are described in detail below: 

 

Toolbar Options 

This Icon … Allows You To Do This 

 
New:  Displays the Manifest Pick List, where 
you can start a new manifest file. 

 
Open:  Displays the File Open dialog box, 
which allows you to open an existing 
manifest. 

 Save:  Saves the active manifest.   

 
Print:  Prints a hard copy of the active 
manifest. 

 
Remove All:  Completely unloads the vehicle 
or pallet. MaxLoad Pro automatically 
transfers all SKU’s in the load to the Cut List. 

 
Remove Placement:  Removes one 
placement, section or stop-off/priority from 
the vehicle or pallet. 

 
Chapter 8:  Viewing a Solution 8.3 



 
Remove SKU:  Removes one SKU from the 
vehicle of pallet. 

 
Put SKU:  Adds one SKU to the vehicle or 
pallet. 

 
Put Placement:  Add one placement, section 
or stop-off/priority to the vehicle or pallet. 

 
Put All:  Completely loads the vehicle or 
pallet.   

 Labels:  Turns SKU labels on and off. 

 
Violations:  Displays a report highlighting all 
current stacking violations. 

 
Units:  Switches measurement units from 
English to Metric and vice versa. 

 
Pick List:  Displays the Manifest Pick List 
screen, where you can change the parameters 
of the manifest. 

 
Edit:  Displays the Editor screen, where you 
can edit the solution. 

 
Back View:  Displays the load from the back 
side of the diagram. 

 

View Buttons (View Screen) 

The View buttons allow you to view the loaded container, pallet, or tote 
from four angles:  Top, Side, Front and 3D.  These buttons are found in 
the upper-left portion of the Manifest View screen, just above the load 
statistics. 

 3D Button:  Displays a standard 3-dimensional view of the diagram. 

 Top Button:  Displays the load from the top, looking down into the 
diagram. 
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 Side Button:  Displays the load from the right side of the diagram. 

 Front Button:  Displays the load looking forward from the rear of the 
diagram. 

Other View Options 

 Rotate:  In addition to the four standard view described above (Top, 
Side, Front, and 3D), you also have the option of viewing the load 
diagram from additional angles.  Any conceivable angle is possible. 

To rotate the diagram, follow these instructions: 

1. Use the mouse to click anywhere on the diagram portion of the 
screen.  This action makes the diagram portion of the screen active, 
thus making it available to be rotated. 

2. Use the arrow keys on your keyboard to rotate the diagram to the 
desired position for viewing.  All four arrow keys are available to 
you, allowing you to rotate the diagram to view from the front, 
rear, top, bottom, right side, and left side (and any angle in 
between) of the vehicle. 

When rotating the solution diagram, it will appear as if the diagram is 
stationary, and you are moving.  For instance, when using the “up” 
arrow  ( ↑ ), it will appear as if you are being raised up and over the 
diagram, allowing you to see the top of the solution.  When you click 
the “right” arrow ( → ), it will appear as if you are moving around the 
solution to the right.  The same is true of the other two arrow keys 
(down and left).   

 Zoom In and Out: MaxLoad Pro also allows you to “zoom in” and 
“zoom out” of a solution diagram.  Zooming in gives you a more 
detailed view of the load.  Zooming out gives you a “big picture” 
perspective. 

To “zoom in” or “zoom out” on the vehicle diagram, follow these 
instructions: 

1. Click on the diagram window to make it active. 

2. Press on the “T” key on your keyboard to “zoom in.”  Press on the 
“Y” key to “zoom out.”  Continue to press on the respective key 
until the diagram is sized to your liking. 
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Additional Viewing Options 

In addition to being able to rotate the solution diagram, MaxLoad Pro also 
gives you three additional viewing options: By Placement, By Leading 
Edge, or By Priority/Stop-Off.  These three options can be accessed from 
the View Menu on the Menu Bar.  These options work in conjunction with 
the arrow buttons found on the Toolbar.  See the section regarding the 
Toolbar for more information. 

 View by Placement:  Allows you to load or unload a manifest “by 
placement.”  A placement is a group of like SKU’s loaded with the 
same dimension vertical and with the same dimension parallel to the 
vehicle or pallet. 

 View by Leading Edge:  Allows you to view the load one section at a 
time. MaxLoad Pro will load the first placement of cargo, as defined 
above.  Other SKU’s will be loaded around the first placement, but 
will not extend beyond the leading edge of the first placement.  Once 
the first section of SKU’s are loaded, another placement is loaded as 
far forward as possible up against the leading edge of the prior section, 
and up against the left wall of the vehicle, or left edge of the pallet.    

 View by Priority/Stop-Off:  Allows you to view the load one priority 
or stop-off at a time.  Remember that you can build a load by priority 
or stop off when defining your manifest in the Manifest Pick List 
screen. 

Load Statistics (View Screen) 

Load Statistics, as pictured below, are displayed on the left side of the 
Manifest View screen, just below the View Buttons.   

 
Figure 8.2 Load Statistics 
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Following are some of the fields available under the load statistics section: 

 Wgt: Total weight and percentage weight of the load. 

 TareWgt: The weight of empty container. 

 TotalWgt: Sum total of Wgt. and Tare Wgt. 

 King Pin, Axle 1, & Axle 2: Total load weight on King Pin and each 
axle. 

 Cube:  The percentage volume of the container filled with product 

 End Gap: The distance between the last loaded SKU from the end of 
the container. 

 COG: Center of Gravity. 

Note:  For Single SKU the information provided in the Load Statistics is 
the SKU and Container’s length, width, and height. 

Tabs (View Screen) 

The List Tabs, at the bottom of the View Screen, allow you to see various 
statistics regarding the load that you are viewing.   

Sol List 

The Sol List or the Solution List, as pictured below, appears whenever 
multiple solutions are calculated for the manifest, depending upon 
multiple container sizes or loading algorithms. 

 
Figure 8.3 Sol List 

MaxLoad Pro even calculates multiple solutions when performing a 
Single-SKU loading analysis.  For more information, please refer to 
Chapter 7, Loading a Single-SKU Manifest. 
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 Truck / Tote: Lists the selected containers for a particular manifest  

 Algorithm:  Displays the loading algorithm used to calculate the 
solution 

 Qty: The count of SKUs loaded in to the container or on the pallet 

 Cube: The total volume of the loaded SKUs  

 %Cube: The percentage of the container or pallet’s volume that 
loaded SKU’s occupy 

 Wgt: Total weight of the product 

 %Wgt: The percentage of the maximum weight that the SKUs weighs 

 CutList Cnt: The total number of the SKUs which could not be 
loaded in to the container or pallet 

Use the scroll bar to scroll through the list.  Also, you can use the mouse 
to highlight a different solution.  Notice that each time you select a 
different solution, the manifest solution diagram redraws to reflect the 
selected solution. 

Placement List 

The Placement List, as pictured below, displays the information for each 
SKU. 

 
Figure 8.4 Placement List 

 Ref / No: Reference number or the Placement number for the SKU 

 Color: The color assigned to the SKU 

 SKU: SKU Number 

 Qty: Quantity of SKU’s loaded in the container or pallet 

 ULCnt: Unitload count (if applicable) is the number of whole 
unitloads for the corresponding SKU in the container or on the pallet.   
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 Priority/Stop-Off number: Determines the  order in which the SKU 
is loaded by Priority / Stop Off, respectively  

 Cube: The volume of that particular SKU times the quantity loaded 

 %Cube: The percentage of the total volume of that container that total 
volume occupied by that quantity of the SKU 

 Wgt: Weight of each SKU times Qty 

 %Wgt: The percentage of the maximum weight that the SKUs weighs 

 XFront, XSide, & XFloor: The location the SKU is loaded from 
front, side, and floor of the container or pallet 

Note: You can print this report through the File menu.  This report can 
even be exported through the Tools menu 

Load List  

The Load List, as pictured below, provides a summary of all SKUs in the 
load.  The information provided in Load List is identical to that provided 
in the Placement List.  Like Placement List this list can also be printed or 
exported. 

 
Figure 8.5 Load List 

Cut List  

The Cut List is the list of SKU’s that did not fit into the selected container 
or the pallet, when CalcAllTrucks feature is turned off.  The information 
displayed in this list is identical to that of the Load List (with the addition 
of a Unitload Count column). 

 
Figure 8.6 Cut List 
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If you do not want any SKUs to appear in the CutList, check the 
CalcAllTrucks feature in the Global Configuration.  For more information 
on Calculate All Trucks feature, please refer to Chapter 11, Configuration. 

Cut List can also be printed through the File menu.   

Note:  Cut List is not available for Single-SKU manifests. 
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Viewing Items on the Cut List  
Once a solution has been calculated, if MaxLoad Pro determines that the 
entire manifest will not fit in the selected vehicle, you have the option to 
take items from the Cut List and load them into other vehicles.  This 
assumes you are not using the CalcAllTrucks feature.   

To determine if the entire manifest fits into the vehicle, simply look at the 
Cut List.  If there are any SKU’s in the Cut List, then the entire manifest 
did not fit.  If the Cut List is empty, then everything in this manifest fits on 
the selected vehicle.  Another way to determine if all SKU’s fit is to check 
the Next Truck button, which is located under the View buttons.  If the 
Next Truck button is “grayed out,” then all SKU’s fit into one container.  
If the Next Truck button is activated, then this manifest requires additional 
vehicles.   

To view items on the Cut List and load them into another container, follow 
these instructions: 

1. Click on the Next Truck button.   

System Response:  The New Truck dialog box appears, as pictured 
below. 

Note:  In situations where you chose to analyze more than one loading 
algorithm or selected more than one vehicle to calculate, MaxLoad Pro 
will warn you that “All solutions other than the one currently being 
viewed will be deleted.” If this is acceptable, click on OK.  If deleting 
the additional solutions is not acceptable, click on the Cancel button. 

 
Figure 8.7 Next Truck Dialog Box 
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2. You will next be asked to select another vehicle from a Next Truck 
dialog box.  You can either select the same vehicle or choose a new 
one. 

Note:  If you only load one type of vehicle and do not want to see this 
dialog box, you can turn it off through the Configuration dialog box.  
For more information, please refer to Chapter 11, Configuration. 

3. Click on OK. 

System Response:  MaxLoad Pro draws a new solution with the items 
previously on the Cut List.  MaxLoad Pro updates the Cut List to 
reflect that fewer items (if any) remain to be loaded as part of this 
manifest.  If the Cut List still contains freight, repeat this procedure 
until all items from the manifest have been loaded onto a vehicle. 

Note:  If at any time you wish to see the previous vehicle in the sequence, 
click on the Prev (Previous) Truck button.  The previous solution will 
appear.   

During the process of loading items from the Cut List, the page title will 
list container or pallet – first, second, etc. – you’re currently viewing.  
This will prevent you from “getting lost” when viewing multiple vehicles 
in sequence. 
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SKU Information 
MaxLoad provides a right-click function that displays properties 
information for a selected SKU.  To display SKU information, start from 
the View Screen and follow these instructions: 

1. Position the pointer over the SKU for which you want to display 
information. 

2. Right-click on the SKU. 

System Response:  A Properties button appears. 

3. Click on the Properties button. 

System Response:  The Properties window appears, as pictured on the 
next page. 

 
Figure 8.8 SKU Properties Window 

As you can see, the Properties window displays a range of basic properties 
for the selected SKU:  name, length, width, height, etc. 

 

 
Chapter 8:  Viewing a Solution 8.13 



 
8.14 MaxLoad Pro (V2.7X) User’s Guide 

 

 


	Viewing a Solution
	Introduction
	Manifest View Screen
	Toolbar (View Screen)
	View Buttons (View Screen)
	Other View Options
	Additional Viewing Options
	Load Statistics (View Screen)
	Tabs (View Screen)
	Sol List
	Placement List
	Load List
	Cut List

	Viewing Items on the Cut List
	SKU Information


